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Getting Started
Each SoftwareVAULT collection contains thousands of programs and resources of every size and variety. 
To help you find your way through this sea of software, we have included the SoftwareVAULT Librarian 
program.    This is a program that will ......

1 Let you sort through the thousands of programs and resources in the SoftwareVAULT collections.
2 Help you find programs of interest.
3 Help you transfer these programs or resources to your hard drive.

Please note that to use SoftwareVAULT files you MUST transfer them to your hard drive before you can 
use them.

The files on the CD-Rom are compressed and must be "UNZIPPED" to your hard drive so they can be 
accessed.    (Don't worry, the Librarian does this automatically for you.) 

(We "ZIP" our files up so that we can include more software on each SoftwareVAULT collection, giving 
you more value for your dollar.)



Tutorial... A lesson in fun
How To Use the Files on This CD-Rom.

You can use any of the thousands of programs and resources on a SoftwareVAULT Collection with just a 
few easy steps:

Find and select an Area of interest. You can either "browse" through various file "Groups" using the 
"Contents" menu item or "Find" specific subjects using the "Search" menu item. You'll discover long lists 
of files, each followed by a one sentence description of what that file does. Once you find one that looks 
interesting, double-click on it with your mouse, or press "ENTER". An extended description will appear.    
Not all files have an extended description so you may see the same information as the single line 
description.    You may also click on the VIEW button.

Find and select a file that you would like to use.    When you click on the VIEW button, you will see a 
picture or the contents of the zip file.    If you have defined an "association" for your graphics files, we will 
run your program associated with the selected file.    (If you are unfamilar with associations, see your 
Windows manual under FILE MANAGER).    If you are viewing the contents of a zip file in the Files 
Processor Dialog, you may copy or unzip this file to your hard disk.      Unless you're a veteran 
SoftwareVAULT user, browsing the file contents and copying the file to your hard disk might be confusing. 
In order to use the file or run the program, THE MENU OPTION YOU ALWAYS NEED TO SELECT IS 
"UNZIP TO HARD DRIVE". Selecting "Unzip to hard drive" will properly decompress the file and transfer it
to your computer.

Select the drive and directory in which to put your file. Once you've chosen to unzip the file to your hard 
disk, a directory selection menu will appear on your screen.    To change the path, click through the 
"Directories" selection box until you find a path that matches where you want to put your de-compressed 
files.    Make a note of where you put your files so you can find them once the Librarian is finished!

Use your file. Exit the Librarian and go to the directory you created to hold your file. You will discover that 
your one ZIP file has probably decompressed into a collection of smaller files. To start the program, look 
for the file with a ".exe" on the end of its name. This is the main executable for the program. Running it 
should start the program!



Files Processor Dialog
There are three different options in the Files Processor Dialog. You can either view the contents of the zip 
file, copy the file to your hard drive, or unzip the file to your hard drive.    Unless you're a veteran 
SoftwareVAULT user, unzipping the file contents and copying the file to your hard disk might be 
confusing.    Selecting Unzip to hard drive will properly decompress the file and transfer it to your 
computer.



Copy a File
To copy a file, do the following:

· When in the File Browser window, put your cursor (the highlighted bar) on the file you are 
interested in and click on the VIEW button.    This will cause the Files Processor Dialog to appear.
· From the Files Processor Dialog, click on "COPY".    This is the first item on the bottom bar.
· Selecting this option will display a "File Save As" window.    Here, you will need to choose the 
directory where the file(s) will be copied to.

If you are Copying more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



UnZip a File
To unzip a file, do the following:

· When in the File Browser window, put your cursor (the highlighted bar) on the file you are 
interested in and click on the "UNZIP" button.    This will cause the Files Processor Dialog to appear.
· From the Files Processor Dialog, click on "Unzip".    This is the second item on the bottom bar.
· Selecting this option will display a "File Save As" window.    Here, you will need to choose the 
directory where the file(s) will be unzipped.

If you are unzipping more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



View a Picture
To view a graphics picture, do the following:

· When in the File Browser window, put your cursor (the highlighted bar) on the file you are 
interested in and click the VIEW button.    If you have defined an "association" for your graphics files, we 
will run your program associated with the selected file.    (If you are unfamilar with associations, see your 
Windows manual under FILE MANAGER).

Loading a picture for viewing may take a few moments.    See the "Tutorial" section of this help file.



GIF
A graphics picture.    The initials stand for Graphics Interchange Format.    If you have defined an 
"association" for your graphics files, we will run your program associated with the selected file.    (If you 
are unfamilar with associations, see your Windows manual under FILE MANAGER).



Menus
From the menus listed below, you can do most anything in the SoftwareVAULT Librarian.    The menus will
assist you in navigating the Librarian and performing all functions.

File Menu
Contents Menu
Search Menu
Text Menu
All CD's Menu
Help Menu



File Menu
From the File Menu you can perform many utility functions including changing CD-Rom's, Setting up your 
printer, printing catalogs or setting up a BBS import of any SoftwareVAULT collection.

Change CD-Rom
Select "Change CD-Rom" to use other SoftwareVAULT Collections.    When you select    "Change CD-
Rom", be sure to place the CD-Rom you would like to use in your CD-Rom drive.

If you are running the Librarian directly from your CD, this option will be disabled.

Export Listings
From this dialog box, select the type of output from the list box on the left (Export List Types).    Then 
select the area(s) you wish to export from the list box on the right (Areas To Export).    If you want to 
export all areas, check the box titled "Tag All Areas".    If you want you output to be in a single file, check 
the box titled "Write To One File".    When you have finished, press "GO" and you will be given a File 
Selection Dialog.    This is where you select a directory to put your file(s) in.    You must also supply a 
filename for the exported file(s).    The export will start and your progress will be displayed.

If you are exporting separate files for each area, the filename will be what you typed in the file selection 
box and the extensions will be 01, 02, 03, etc.

Print Listings
From this dialog box, select the type of output from the list box on the left (Printed Form Types).    Then 
select the area(s) you wish to export from the list box on the right (Areas To Print).    If you want to print 
all areas, check the box titled "Tag All Areas".    If you want you output to be in a single file, check the box
titled "Print To One List".    When you have finished, press "GO" and you will be given a Print Dialog.    
This is where you select a printer.    After your selection, press "OK".    Your printing will start and your 
progress will be displayed.

If you are printing separate files for each area, a formfeed will be issued and the next area will start on a 
new page

Printer Setup
Use this command to select a printer and a printer connection.

Dialog Box Options
Printer
Select the printer you want to use; only installed printers appear. You install printers and configure ports 
through the Windows Control Panel. For information on installing printers, see your system 
documentation.

Setup
Displays a dialog box so you can control default printer settings for the printer you select. For more 



information, choose the Help button after you choose the Setup button.

The options in the setup dialog box will vary, depending on the printer you have installed. The title of the 
setup dialog box also changes to reflect the printer.

Exit
Select "Exit" to leave the SoftwareVAULT Librarian.



Contents Menu
The Contents Menu allows you to explore SoftwareVAULT in two different ways with either Group 
Browser or Browse-Copy Files. It also contains Hottest Hits and Statistics.

Browse-Copy Files
If you don't want to sort through groups of software categories, you can explore the entire category list. 
Clicking on a specific category will bring up a complete list of all the programs and resources contained in 
that category. See the Tutorial section of this help file to see how to use these programs.

Hottest Hits
Each SoftwareVAULT collection contains an assortment of the very best shareware programs on the 
market today. "Hottest Hits" Info contains complete reviews of these outstanding programs.

Statistics
Statistics provides a statistical breakdown on the makeup of this SoftwareVAULT Collection. It displays 
File Areas, Total number of files in each area and the total number of File Bytes used by each area.



Search Menu
The SoftwareVAULT Librarian allows you to search for files that interest you in several different ways:

Choose Area
Executes the Librarian's Browser-for a specific area.

Find Filename
Allows you to find files based on their title. Type a title into the Find File box and click on the OK button. 
The Librarian will assemble a list of the files with titles similar to the one you specified. See the Tutorial 
section of this help file to see how to use these programs.

Find Text
Allows you to run a keyword search to find files on certain subjects. Type a keyword into the Find Text 
box. The Librarian will sort through the descriptions of all the files on the disc and will list files with 
subjects related to your keyword. See the Tutorial section of this help file to see how to use these 
programs.



Text Menu
The text files contain information on how the SoftwareVAULT collections are assembled and how you can 
register shareware programs requiring registration.    You will also find information about Digital Impact, 
the copyrights on the Librarian, warranties and Technical Support. There is also information about the 
virus precautions we take and the utilities we use.



All CD's Menu
Selecting All CD's allows you call up a master files listing for all of the other SoftwareVAULT collections.    
The master listing is topically organized by Rom and then by Area.    Files are alphabetical within each 
area.    The SoftwareVAULT collections are listed below and will appear in a window on the bottom left of 
the Browser.    The Area that the file is in will appear in a window on the bottom right of the Browser

If you would like to examine a listed file use the Change CD-Rom function found under the File menu to 
switch to the appropriate collection and then the Find Filename function in the Search menu to retrieve 
the file.

All CD's uses a global search for text.    Click in the magnifying glass to invoke the Find Dialog.    This 
search will even find text contained in other text.



Help Menu
Selecting help opens this help file. If you are having difficulty understanding how to use this help file, click 
on the "Help" menu item above.    Or, if you're really in a hurry, click on the Speedbar button.

From this menu you may also select "Help On Help", "Search for Help on ...", learn "How to use Help" 
and see "About" the Librarian.



Speedbar
The SoftwareVAULT Librarian is equipped with a speedbar.    This is a group of pushbuttons that makes 
using the Librarian quick and easy.

This button will activate the search by area (or category) function.    A list showing all areas available will 
pop-up and you can select an area to browse.

This button displays the Find Text window.    This is where you enter any text that you want to find, and the
Librarian will find all files with this text in their description.

Clicking your mouse on this button will close the Librarian and return you to the Windows Program 
Manager. This has the same effect as selecting "Exit" from the File Menu.

Clicking this button will get you detailed Help in a hurry.



Keyboard
Alt-F    -    Activates the File menu.

Alt-C    -    Activates the Contents menu.

Alt-S    -      Activates the Search menu.

Alt-T    -      Activates the Text menu.

Alt-A  -      Activates the All CD's menu.

Alt-H    -      Activates the Help menu.



Digital Impact
Digital Impact is primarily a software publisher. We design, publish and directly support a line of 
proprietary software in several categories.

We design a wide range of products, ranging from a menu and utilities package to a to a multimedia 
"edutainment" product.    Our products are designed for a wide range of computer users -- from the novice
to the expert.

We also assemble, manufacture, and distribute the    SoftwareVAULT CD-ROM shareware collections.    
Our SoftwareVAULT line is unique because it offers a large collection of shareware:    users will find 
hundreds of megabytes of useful programs, utilities, and much more.    Furthermore, no shareware title is 
duplicated on any of our other general collections.

Each SoftwareVAULT collection includes the SoftwareVAULT Librarian, a complete database of all the 
files on the CD-ROM.    With this powerful tool you can browse and search by subject or "keyword" for 
specific shareware files.    Once a file is selected, you can tell the librarian to create the necessary 
directory.    The file will then be copied or de-compressed to the directory and is then ready for your use.

What sets Digital Impact apart from other software publishers is that we stand behind every product we 
sell and we value every one of our customers.    When you call our technical support staff, you will always 
speak with an experienced person who is very familiar with our products.    We provide genuine help when
you need it and we offer the same high quality service to all users, retailers, distributors, and OEM's.

For your convenience, we maintain a 24-hour Bulletin Board System (BBS) with separate conferences for 
each of our products. In addition to a large library of shareware available on the BBS, information can be 
exchanged by our customers, programmers, and software retailers.    The BBS also supports online credit 
card orders for our products.    Or, you may order by phone during business hours.

Shareware authors who wish to have their software considered for future SoftwareVAULT Collections 
should send complete copies of their programs to:

AUTHOR SUBMISSIONS
Digital Impact, Inc.
6506 South Lewis      Suite 250
Tulsa, OK    74136
BBS:    (918) 742-8037
Phone:    (918) 742-2022





Other Products
SoftwareVAULT: The Diamond Collection
The SoftwareVAULT Diamond collection contains thousands of the newest programs and 
resources available.    Various areas of interest are Multimedia, games, education, business, 
Windows, graphics, sounds, desktop publishing, word processing, fonts, clip art, databases, virus
protection, LAN utilities, BBS utilities, and more!    There are no duplicates from our other 
general collections.

SoftwareVAULT: The Sapphire Collection
This SoftwareVAULT collection contains software from all of the following categories: 
Multimedia, games, education, business, Windows, graphics, sounds, desktop publishing, word 
processing, fonts, clip art, databases, virus protection, LAN utilities, BBS utilities, programming,
health, food, and much more!

SoftwareVAULT: The Collection for Windows 2
From the makers of the critically-acclaimed Collection for Windows comes the all-new 
Collection for Windows 2.    In compiling this collection, the SoftwareVAULT editors once again 
carefully selected software of all varieties to universally meet the needs of every Windows user. 
The Collection for Windows 2 includes games, business applications, home software, 
productivity tools, and desktop utilities. Regardless of what type of Windows user you are, there 
is bound to be something on The Collection for Windows 2 for you.

SoftwareVAULT: The Games 2 Collection
This bestselling new collection contains hundreds of the most thrilling games in shareware today,
enough to keep any user entertained for months. SoftwareVAULT Games 2 contains adventure 
games, arcade games, board games, casino & card games, education, flight simulators, hints, 
miscellaneous games,    puzzles, game programming, trivia, role playing games, sports, war 
games, virtual reality, and Windows games.

SoftwareVAULT: The Ruby Collection
The eighth of the SoftwareVAULT Collections, and what a collection it is.    Thousands of all 
new files, new Librarians for both DOS and Windows, new file search capabilities, and an all 
new history file so that you can find any file in any collection.    Windows games, business 
applications, fonts, clip art, virus protection, and much, much more!    

SoftwareVAULT: The Emerald Collection
Exploring a shareware collection has never been so easy!    The latest edition of the 
SoftwareVAULT Librarian allows you to quickly and easily explore the thousands of files on the 
Emerald collection.    The enhanced Librarian features a user-friendly interface, global search 



functions, and extensive help capabilities.    The Emerald Collection contains all new files from 
1994 with no duplicates from earlier collections.    These are a few of the reasons that the 
Emerald Collection is Fantastic!

SoftwareVAULT: The Platinum Collection
Over 600 megabytes containing thousands of the finest and most recent shareware programs and 
resources available.    Over 50 exciting categories including Windows, games, graphics, music, 
multimedia, productivity, desktop publishing, and much more. Both a Windows and DOS 
interface will help you explore the Vault for applications that interest you!

SoftwareVAULT: Collection for Windows
A comprehensive collection of every Windows utility imaginable.    An absolute necessity for 
both home and business Windows users. Includes file managers, network utilities, desktop 
publishing programs, Windows games, business applications, fonts, clip art, virus protection, and
much, much more!    Thousands of programs and resources packed on one CD-ROM disc.    
Comes complete with the SoftwareVAULT Librarian to manage the many files included.

 SoftwareVAULT: The Games Collection
Unseal this latest collection of the hottest games on the market today!    A perfect gift for anyone.
Contains games of all types:    Arcade games, war games, flight simulators, casino games, 
adventure games, puzzles and much, much more!    Months of entertainment, hundreds of games 
packed on one CD-ROM. Comes complete with the SoftwareVAULT Librarian to manage the 
many files included.

 SoftwareVAULT: The Gold Collection
The third release in the SoftwareVAULT series, The Gold Collection contains thousands of the 
best shareware programs, including such recent software categories as Windows NT programs.    
It is truly one of the finest software collections ever assembled!    The Gold Collection comes 
complete with the latest DOS and Windows versions of the SoftwareVAULT Librarian program.

ImageVault
Sharp, fresh images.    Substance and style.    Simplicity.    Hundreds of impressions from 
nationally renown photographers capturing people, lifestyles, industry and nature.    
ImageVAULT electrifies your projects with stock photos that steal the breath and excite the 
mind.    Quality resonates in this extraordinary collection of imagery compiled with professional 
standards firmly in mind. Each image is available in three different image formats:    Wallet, 
Snapshot and Standard.

ImageVAULT Pro



The highest resolution, brilliant color, flawless images.    ImageVAULT Pro is a potent, cost-
effective solution to your photographic needs.    The agile browsing software optimizes freedom 
of choice.    Every shot is effortlessly customizable to fit the project; crop, resize, retouch, 
combine and rotate however you please.    Absolutely royalty and credit free.    Create exceptional
graphics with contemporary, powerful photographic images.    Bring newsletters, invitations, and 
presentations to life!    The professional stock photos are available in five different formats:    
Wallet, Snapshot, Standard, Large and Poster.

Ozzie's World™
Kids are naturally curious about how things work in the world around them.    Ozzie's World™ is 
the fun way to help them understand.    It develops memory, critical thinking, problem solving 
and basic science skills, too!    With engaging animations, sound effects, stories, games and 
music, Ozzie's World™ is a multimedia wonderland for parents, educators and kids alike!

In Ozzie's World™, kids join Ozzie S. Otter™ on a magical, animated, earth-friendly 
exploration.    It's a wonderfully engaging environment where animals talk and share their stories,
and where puzzles, games and fun scientific activities are hidden around every corner.    Kids will
be enchanted as they learn about science and simple ways to protect the environment.

Professor C.D. Smart
Professor C.D. Smart is great for first time computer users needing to learn Windows 3.1 
beginning with the basics.    It's also great for experienced users wanting to enhance their 
working knowledge of Windows.

· Learn what YOU need to learn and learn it at YOUR own pace.
· Your teacher's voice will guide you step-by-step, just like a classroom.
· Learn to change your Windows system to meet YOUR needs.
· Learn to keep your files organized and easy to find.
· Learn to make icons for those programs you use frequently.

The Course Outline includes the following lessons ....

1 Course Instruction
2 Working with Windows
3 Executing and Controlling Programs
4 Managing Program Manager Groups



5 The Options Menu
6 Getting Help
7 Disks, Files and Directories
8 The File Manager
9 Customizing Your Windows Environment
10 Printing

This is the easy interactive way to learn the basics of Microsoft Windows.    Through the use of audio 
instruction, simulation, and hands-on training with your own Windows system, you will become a 
Windows power user.



Unzip To Hard Drive
Selecting this option will display a "File Save As" window.    This is where you choose the directory to 
unzip the file(s).

If you are unzipping more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



All CD's
This is a reference to a history file of all CD-Rom collections from the SoftwareVAULT.



Areas
An Area is a sub-directory on the CD-Rom that contains all files of a simular nature, i.e. "Games". We also
use the word "Category" interchangeably with "Area".



BMP
BMP stands for Bit MaPped graphic.    This is a common graphics type used by Windows programs.    
A .BMP graphic can also be used for Windows wallpaper.    If you have defined an "association" for your 
graphics files, we will run your program associated with the selected file.    (If you are unfamilar with 
associations, see your Windows manual under FILE MANAGER).



Browser
This is the large list box that allows you to see a listing of the files in a given Area or Category.    These 
files may have extensions like "GIF", "BMP" or "ZIP".



Category
An Category refers to a group of files on the CD-Rom that contain files of a similar nature, i.e. "Games". 
We also use the word    interchangeably with "Area".



Dialog
A window that asks you a question requiring a response, or gives you an informative message.



Find File
When you use the Find File dialog from the Search Menu, you may enter any filename (or part of a 
filename) and the Librarian will search for it.



Groups
A Group may contain references to one or more Areas or Categories.    If a Group button on the main 
window is "grayed out", it means that there are no files or Areas that apply to that collection.



Librarian
This is the File Manager designed for and used by the SoftwareVAULT collections.



Shareware
Shareware software is a unique marketing approach which allows you to purchase software directly from 
the author.    This eliminates costly marketing,    promotion, and packaging;    allowing you to obtain quality 
software at a fraction of the commercial cost.    You are encouraged to examine a program, copy it, and 
pass it on to    friends.    If you find the software program useful, you are asked    to register with the 
software author.    This usually means paying a registration fee directly to the shareware author.    In    
return for    this registration fee,    you receive the right to continue to use the software and added benefits 
such as full    documentation, technical support, and future updates of the program.    This is the Try-
Before-You-Buy concept.



SoftwareVAULT
The name of a series of CD-Roms produced by Digital Impact.    These CD-Roms contain shareware files 
and programs, Public Domain files and programs, and Pictures or Clip Art.



Unzip
The process of removing (uncompressing) files from their envelopes.    This is the opposite of Zipping (or 
compressing) the files.



Zip
A process of compressing many files into one file.    This process saves space and insures that files stay 
together.






